Chapter 2 Advanced Charting

cC H A P T E R :!

Advanced Charting

eSignal’s Advanced Charting offers an extremely flexible user interface and
includes a full array of line drawing tools, advanced analytics and a formula engine
that lets you create your own studies.You can import and create, save and even
encrypt your own formulas, select from an extensive library of formulas and
helpers, use advanced scaling features and customize your own Advanced Charting
Favorites Toolbar.

You can choose from the following Advanced Chart types:

Daily charts: Daily charts display historical daily data for an issue in
graphical format.

Interval charts: Interval charts track an issue’s current and previous
intraday days’ prices in time intervals that you choose such as 15, 30, or
60 minutes.

Note: You can retrieve up to 120 days of interval data in an Advanced Chart
window.

You can access the Advanced Charts through the Advanced Chart Toolbar, the
Chart Options menu, or by right-clicking inside a bar chart.
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eSignal Advanced Chart Styles

eSignal’s Advanced Charting supports the following chart styles:
Bar

Candlestick

Line

Kagi

Point & Figure

Point Break

Renko

Each of these chart types is described in the following sections.
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Bar
I A Bar Chart displays a series of bars for the interval you specify. This bar
is comprised of four separate data points:
Open: the opening price of the issue at the beginning of the bar interval
High: the highest price the issue reached during the bar interval
Low: the lowest price the issue reached during the bar interval.
Close: the closing price of the stock at the end of the bar interval.

The Open, High, Low and Close are specific to the time frame covered by each
bar. A Bar’s height is derived from its high and low prices during the period it
covers. The Open is displayed on each bar as a small horizontal tick to the left
side of the bar while the Close is shown on each bar as a small horizontal tick to
the right side of the bar.

High————

Open

Close

Low

If an OHLC Bar is green, that means that its closing price was higher than its
opening price. Conversely, if an OHLC bar is red, its closing price was lower
than its opening price.

Symbol: DELL,D
Date: 10/20/06
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Candlestick

* Like Bar charts, Candlestick charts plot open, high, low, and close data for
the chart interval you specify. However, Candlestick charts display OHLC
data in a more visual way which many traders find appealing.

The body of a Candlestick is drawn as a rectangle between the opening and the
closing prices during the interval (e.g., 15 minutes). You will notice that Candlesticks
are either red or green in an eSignal Advanced Chart window. Candlestick
coloration depends on the price activity during the interval the Candlestick
represents. The wicks at the top and the bottom of each Candlestick represent
the high and low prices traded during the interval.

Symbol: DELL,D
Date: 11/14/06
Time: 00:00
Price: 205143522

Open 25.55
High 25.81
Low 25.03

Close 25.59
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A Closer Look At Candlesticks

If the open is greater than the close, the Candlestick is colored in red. Conversely,
if the Open is lower than the close, the Candlestick is green.

High High
Open
Open
Close L Close
ow Low
Up Candlestick Down Candlestick

To change the colors or line styles used for a Candlestick chart:
1 Right click on the Chart and select Edit Studies.

2 The Study Properties window opens. Customize your color and line choices
(thin wick or fat wick).

3 When you are finished making changes, click Apply This and then OK to
make the changes to the current study while the Properties window is open.
Click Apply All and then OK if you made property changes to several studies
and want to change them all while the window is still open.

Chart Type: | Candle V
Up Candle: Candle Cutline:
Hollow
R —
Down Candle: Wick Color:

lij [JHollow _ j

[]use Up & Down Bar Color for Candle wicks {default is Widk Color)
[] show Thin Candle Wicks

Outline Candles
Use Outline Color to outline candles

OHLC Background In Cursor Window _j Display Description:
Filtered Bar Color |:|j
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Line

A Line chart plots the closing price for the interval you specify (i.e. 5
minute intra-day). If you are overlaying multiple symbols on a chart, using
a Line chart format makes the chart easier to read.

Shortcut: Press the Home key to go to the latest bar in the active Advanced
Chart window.
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Kagi

Kagi charts plot a single line until price reverses by a predetermined amount

where another line is then begun. It is an attempt to smooth out the noise
of daily trading activity so that trend can be more clearly represented. The thickness
of Kagi lines are significant when prior highs and prior lows are exceeded.
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Point and Figure

«  Pointand Figure charts disregard the passage of time and chart only price

“  changes. An "x" is drawn when the price rises by a predefined box size.
An "0" is drawn if the price falls by a predefined box size. No x's or 0’s are
drawn if the market moves an amount less than the box size.
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Date:

Tirme:

Price: 1
Open 36. I]I]
High 42.00
Low 36.00

Close 42.00
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Point Break

I A Point Break chart displays new lines if the close of the period moves
outside of the period of the previous block of trading. If not, then no lines
are drawn.

The first line is drawn when the prices are greater, lower, or the same as the
opening price. If prices exceed the prior high (low) price a new line is drawn If
current prices are within the prior high or low, no new line is drawn.

When using a Point Break chart, prices must exceed the prior three high or low
lines to indicate a reversal.
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Renko

Renko charts display price movements if they are bigger than a fixed
o amount.

Symbol: DELL,D
Date: 08M12/05

Time: 00:00
Price: 18.6957996
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Anatomy of an Advanced Chart Window

An Advanced Chart window displays historical data for issues in graphical form.
The data displayed is determined by the symbol you enter, the chart type and the
time interval you select.

Favorites
toolbar

Cursor

window
P s P I ....... 240.0

- |
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Charting
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What could be simpler than clicking a toolbar button to pull up an Advanced Chart
window that you access often? eSignal’s Advanced Chart window contains a
Favorites Toolbar that lets you access your favorite charts instantly. The Favorites
toolbar lets you pull up preset charts that you can further customize to meet your
needs.

When you initially open an Advanced Chart, the Favorites toolbar contains certain
preset folders (Equities and Other Intervals) and shortcuts (1 minute interval
chart, Daily etc.). You can experiment with the Favorites toolbar shortcuts and
pull-down menu choices and then customize them to reflect your own needs.

You can customize the Favorites toolbar by adding new shortcut folder names
and favorites names within the folders, by removing existing favorites shortcuts,
chang-ing the content of existing folders, and even adding new direct toolbar
shortcuts.
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When you open an Advanced Chart window, the Favorites Toolbar appears at
the top of the window.

= B + || Equities + |_] OtherIntervals » (B IDC (T) 1 (I} 5 () 60 (D) Daly ¢I) Tick

The Favorites toolbar contains several chart shortcut icons.

== Clickthe Link button to link the active Advanced Chart window symbol
== to your Quote window cursor. When the link feature is enabled, the
Advanced Chart window symbol changes whenever you move your cursor to a
new symbol.

Click the Properties button to open the Properties window, where you
can customize your favorite charts and set other chart options.

=4 Click the Add button to add a new custom chart to your Favorites toolbar.

Click the arrow next to the Equities button to select
a favorite equity chart from those you have already

__| Equities ~ saved to the Equities folder.

Click the arrow next to the Other Intervals buttonst

1 Other Intervals ~ to apply them to the active Advanced Chart window.

@ DC Click the IDC button to convert the active Advaced Chart window
to a daily chart for the symbol IDC.

Click the 1 button to change to a 1 minute intraday chart for the
@ 1 active Advanced Chart window symbol.

Click the 5 button to change to a 5 minute intraday chart for the
@ 3 active Advanced Chart window symbol.

Click the 60 button to change to a 60 minute intraday chart for
@ a0 the active Advanced Chart window symbol.

_ Click the Daily button to change to a daily chart for the active
(T) Daily Advanced Chart window symbol.

Click the Tick button to change the active Advanced Chart to a
@ Tick tick chart.
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Building a Favorites List

You can use the Favorites toolbar to create your own favorite list of symbols and
intervals (e.g. INTC, 5), symbols (INTC) and intervals (e.g. 5) used to quickly
retrieve the exact charts you need. To add to your favorites list:

1. Click the Add button. The Add Favorite window opens.

Use: ) Interval
Symbal: | pELL
Interval: |
Name:
(L] Equities
[C other Intervals Mew Folder, ..

2. In the Use area, select either Symbol & Interval, Symbol, or Interval.

3. Enter the symbol, interval (D=Daily, 15= 15 minutes, T=Tick, etc.), enter a
name for the favorite, select a folder where you want to save the favorite, and
click OK.

4. 1If you want to create a new folder, click on the Favorites folder and then
click the New Folder button. Then enter the name of the new folder in the
window that appears and click OK to save it. You can also create folders within
folders (by clicking on the + sign).

5. If you want to add a Favorite shortcut button directly to the Favorites toolbar,
close the Favorites folder if it is open by clicking the -to its left. Then add a new
favorite name, symbol and interval and click OK to add it.

Thereafter, you can access new favorite charts from the Equities, Other Intervals,
or other pull-down menus you have defined or, directly from a Favorites toolbar
icon.

2~23
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Managing Your Favorites List

To manage your favorites list, click the Properties button on the toolbar to view
saved favorite charts in the Equities, Other Interval, Favorites and other user-
defined folders. The My Favorites window opens.

My Favorites 1

[] auto Hide (this only works if Favorites Bar is docked)
[ ]Hide Images on top level of toolbar
[]Place Separators between top level items (useful if hide images is on)

Manage Favorites

([ Equities
[ other Intervals
{5 oc
(D1
T s
(I &0
@ Diaily
(I Tick

| Ok | [ Cancel ]

* Expand the Favorites, Equities, or Other Intervals folders to list currently
saved favorites in these folders. To remove a favorite, click on it and then click
the Remove button.

* To add a new favorite chart to the list, click on the + on the Favorites toolbar,
select the folder you want to save it in, then enter the symbol, interval, and favor-ite
name in the window that appears, and click OK to add the new favorite.

You can also create new favorites folders. To create a new folder, click the + on
the Favorites toolbar, click on the Favorites folder in the My Favorites window,
enter a folder name, then click the Add Folder button. Once you have created a
new folder, select it from the My Favorites window, then enter a new symbol,
interval and name for each favorite chart that you want to put in the new folder.
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* The Favorites Toolbar supports auto hide. You enable auto hiding by clicking on
the Properties toolbar button, checking the Auto Hide box, and clicking OK. When
the auto hide feature is active, the Favorites Toolbar appears when you move
your mouse cursor where it was resizing, and disappears when the mouse is
moved off the toolbar.

* The Favorites Toolbar is dockable to other edges of the window (top, bottom,
left, right). All other eSignal toolbars are dockable too. If a toolbar is docked, you
can turn on the autohide feature.

* You can conserve screen space on the toolbar by selecting some options under
properties (separators between top level items, hide images).



eSignal, Part 1 User’'s Guide

Cursor Window

The Cursor window displays the data for the bar or point you currently have
high-lighted. Itis displayed by default when you open an Advanced Chart window.
You remove the cursor window by de-selecting it from the Advanced Chart
Right-click or Chart Options menus, or, or clicking on the Cursor Tracking icon
on the Advanced Charts toolbar.

When you right-click in the main chart area or select the Chart Options menu,
the following Cursor options appear.

Chart Options
@‘ Properties...
Style Templates L
Time Templates k
Wiew k
Chart Type »
Scaling »

T~ Cursor Tracking

w  Tile Studies Lock in Place

Stack Studies Small Cursor

Edit Studies. .. Froperties...
Integrated Trading k
Basic Studies L
Advanced GET Studies »
Add-On Studies r
1 Formulas r
Remove k
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Just right-click on a Cursor Window to access the following menu and customize
its look and feel.

Req Sent...
Symbol: DELL,D

Date: 08/31/06

Tirmee: 04000

Price: 24 101

Open 22.85 Send Image To b
High 23.31

ol | [ Hide Cursor Windaow
Close 22 55
DC[20Upr 23.35 Properties...
DC[20)Lwr 20.65
et |+ (DELL - DELL INC,D) Dynamic,0:00-24:00
DC{20)Upr 2335
el RS-l N | Donchian{20)
0 Bas 22.00
= |+ AutoTrend Channels
v Donchian(20)

See the “Using the Right-Click Menus” section later in this chapter for further
detail.

Charting Area

The charting area contains the actual chart. Depending on the chart type and
properties you’ve set, the chart area may include a cursor window, cursor tracking,
avolume histogram, and various technical studies.

Using the Advanced Chart Toolbar

In addition to the Favorites toolbar that is embedded inside an Advanced Chart
window, there are several other charting-related toolbars that you can use to
customize your charts: the Advanced Chart Toolbar, the Line Toolbar and the
Advanced Line Toolbar. For more information about the Line Toolbar and the
Advanced Line Toolbar, see Chapter 3: Line Tools.

You can toggle these three toolbars on and off by selecting/deselecting them
from the eSignal View menu. In addition, all eSignal Advanced Charting toolbars
are dockable, which means that they can be moved anywhere on your screen.
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il G & (AL 1 @ o B oo

Click the Bar Chart J  button to pull up an open, high, low, close bar chart.
Click the Candlestick * button to pull up a Candlestick chart.

Click the Line .~ button to pull up an OHLC line chart.

Click the Point and Figure %a button to pull up a Point and Figure chart.
Click the Point Break '-,| button to pull up a 3 Line Break/3 Point Break chart.
Click the Renko & button to pull up a Renko chart.

Click the Kagi " button to pull up a Kagi chart.

Click the Auto Scale ﬁ button to Auto Scale chart data.

Click the Scale Price j:button to Scale Price data only.

Click the Logarithm »@-{ button to switch to a logarithmic scale.

Click the Increase Bar 'ﬂ: Width button to increase bar width.

Click the Decrease Bar 1_ Width button to decrease bar width.

Click the Increase Bar Spacing 4+ button to increase bar spacing.
Click the Decrease Bar Spacing k4 button to decrease bar spacing.

Click the Cursor Tracking ‘|— button to have your Advanced Chart symbol
track your cursor.

Click the Cursor Window B button so that the Advanced Chart window
displays a Cursor window that shows data for the bar or point your Advanced
Chart cursor is on.

Click the Reset “{m button to reset your chart.

Click the Advanced Chart Properties@’button to specify Advanced Chart
window properties.
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Viewing Data in an Advanced Chart Window

You can create a new Advanced Chart window by right-clicking a symbol in a
Quote, Portfolio, Summary or Leaders window and selecting Advanced Chart, or
by choosing New from the File menu. If you already have a Chart window open
and don’t want to open another one, you can display a new chart in the open
Advanced Chart window.

To display a new chart in an open Advanced Chart window:

1. Make sure the Advanced Chart window is active, then just type a new symbol.
A Change Symbol window opens as shown below. Type in a new symbol and
interval, then click OK. The Advanced Chart window you had open changes to
reflect the new symbol and interval you entered. Available intervals that you can
enter are D (for Daily), W (for Weekly), and M (for Monthly), and intervals in
minutes (i.e. 60, 30, 15, etc.).

Symbol: | DELL

[ Multiple Symbols == ]

2. When you initially open an Advanced Chart window, there are preset chart
intervals and Favorites lists (lists of preset charts) for Equities and Other Intervals
that you can choose from the Favorites Toolbar as shown below.

= E&' + || Equities ~ | ] OtherIntervals » (B) IDC (T) 1 (T3 5 (Ty &0 (D) Dally (I) Tick

3. You can quickly change the interval for data in the Advanced Chart window by
selecting from the preset intervals of 1, 5, and 60 minutes and Daily from the
Favorites Toolbar.

To redisplay a Favorite chart in an Advanced Chart window:

I. Click the down arrow on the Equities list or the Other Intervals list or any
other user-defined folder list and select the name of a previously saved favorite
chart from the pull-down list.
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Specifying Advanced Chart Window Settings

You have complete access to Advanced Chart Window settings by using either
the Advanced Chart Window right-click menu and/or the Chart Options menu.
The Advanced Chart Window right-click menus vary, depending upon where you
click on the chart.

If you right-click in the data area of the Advanced Chart window, you will see
the Main Advanced Chart window right-click menu that is discussed in the

following section.

Main Advanced Chart Right-Click Menu

Once you have created an Advanced Chart window,
you are just a few right-clicks away from
customizing window properties, changing chart
styles, selecting scaling methods and cursor options,
adding and editing studies, formulas and advanced

Send Image To

Properties...

line tools, and un-merging and removing existing s
studies. Time Templates
Please note that you can access the same Advanced den

Chart window settings menu by clicking on the Tools

Chart Options menu when an Advanced Chart Chart Type
window is active. The only difference between the P
Advanced Chart window right-click and Chart —
Options menu is that the right-click menu enables Li;ﬂmls

you to select individual studies while the Chart
Options menu does not.

Tile Studies
Stack Studies

Edit Studies. .
Set Alert 24,7598, ..

Integrated Trading

Basic Studies
Advanced GET Studies
Add-On Studies

Formulas

Remove
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Properties

Click Properties to specify chart colors, fonts, margins, and ticker filtering settings.

Chart Properties 1

Colars

T j
[ Tcursor Window Text

I -

I i

I <<

I - = Label FG
[ scrolled Label BG

Font

Font... ‘

Preview Sample

Right Margin Offset; | 0 {:}

Tick Filtering [] solid Horizontal Grid
[Joraw Lines On Top of Price [] solid Vertical Grid Lines
Force Suffix On All Linked Symbuols Draw Study Titles

(ie "=N" for NYSE reqionals):
|:| Mini-Price Tracking Cursor

I OK I [ Cancel
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Style Templates

You may want to set up different Style Templates for various types of issues.
You can do this by saving each of these Advanced Charts as a separate Style
Template so that you can load it whenever you want.

Select Style Templates to load a particular style template, to save a chart as a
style template, to set a particular chart as your style template, or to load the
default chart style template. The default eSignal style template is called
Default.ach. However, you can make any existing advanced chart a style template
and once you save it as the Default, it will then be available.

Send Image To L
@’ Properties...

Style Templates r Load...

Time Templates r SEVE...
View »
- Set As Default
Tools r Load Default
Chart Type r
Scaling k
Cursar L
Line Tools r
v Tile Studies
Stack Studies
Edit Studies. ..

Set Alert 0.00...

Integrated Trading L
Basic Studies L4
Advanced GET Studies L
Add-0n Studies k
__| Formulas r
Remove L
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Time Templates

Select Time Templates to load a particular time template or to load one of the
default chart time templates that comes with eSignal.

Template files all have the suffix of.ach (i.e. Advancedchart.ach) and are stored
under the eSignal program directory. The Style and Time Templates submenus
can also display up to 4 of the most recently saved or loaded templates for easy
access.

Send Image To ¥

@ Properties. ..

Style Templates ¥
Yew g Equity RTH - West Coast
Tools » Equity RTH - East Coast
Chart Type r 1Day
Scaling r 2Day
Cursor » 24 Hour
Line Tools » Future
Day Only
v Tile Studies emm_FT
Stack Studies FT
Auto
Edit Studies. ..

Set Alert 22.7757...
Integrated Trading ¥

Basic Studies *
Advanced GET Studies L

Add-On Studies ¥
__] Formulas r
Remove ¥
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To Edit A Time Template:
1. Right-click on the main data area of an Advanced Chart window.
2. Select Time Templates, then Edit from the right-click menu.

3. The Time Templates window opens. It lists all default templates and any
others that you have saved. The Time Template that is currently being used by
the active chart is highlighted and its Template items are listed in the Template
Items section of the window.

Tl' me Templates 1

Mame Interval  #Days Start Time End Time
Equity RTH - East C...

1 Day

2 Day

24 Hour

Future

Day Only

emm_PT

PT

Auto

[ e e e e R R |

Mote: all times associated with Time Templates are in Local Time, regardless of your
global times display setting!

Selected Template: Equity RTH - West Coast

intraday intervals
End Time:

Close

Template Items Templates
TVPE! [IntradayDefault || [ Uodatefadd | [ ew Template... |
Interval: Delete Template
#Days | g 0 is dynamic mode Rename Template
@' Days {} Bars Capy Template
Start Time: Start/End times are only valid on

[ ] Automatic Start/End Times
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4. You may change the Default Type, Interval, number of days or start and end
times.

5. When you are finished updating the selected Time Template, click the Update/
Add button.

6. You can also use the Time Templates window to create a new template (click
the New Template button), delete an existing template (click the Delete Template
button), rename a template (click the Rename Template button), or copy an
exist-ing template (click the Copy Template button).

7. When you are finished managing your Time Templates, click the Close button
to close the Time Templates window.

Title Bar

Select Title Bar from the Advanced Chart right-click menu to toggle the Advanced
Chart window title bar on and off.

Chart Types-Description & Interpretation

Bar

Select Bar from the Chart Type right-click submenu to change the active
Advanced Chart window to an OHLC (Open, High, Low, Close) Bar chart.

Candlestick

Select Candlestick from the Chart Type submenu to change the active Advanced
Chart window to a Candlestick chart.

Line

Select Line from the Chart Types submenu to change the active Advanced Chart
win-dow to a Line chart that connects the closing prices (by default) for each
chart inter-val. You can also base the Line chart on a variety of price sources
such as open, high, low, close, or combinations of these sources. When a line
chart is active, right click and select Edit Studies to select from several Sources
on which you can base the line.

2~35



eSignal, Part 1 User’'s Guide

Point and Figure

Select Point and Figure from the Chart Types submenu to change the active
Advanced Chart window to a Point and Figure chart. Point and Figure charts
disre-gard the passage of time and chart only price changes. An "x" is drawn
when the price rises by a predefined box size. An "0" is drawn if the price falls by
a predefined box size. No x's or 0’s are drawn if the market moves an amount
less than the box size.

Point Break

Point Break charts originate from Japan and were introduced to the western
world by Steve Nison (author of Beyond Candlesticks).

A green block is drawn in a new column on the chart if the closing price exceeds
the previous high price. Conversely, a new red block is drawn if the close makes
a new low. If there is neither a new high or low, nothing is drawn.

With a default Point Break, if a rally is powerful enough to form three consecutive
green blocks, then the low of the last three green blocks must be exceeded
before a red block is drawn. If a sell-off is powerful enough to form three
consecutive red blocks, then the high of the last three red blocks must be exceeded
before a green block is drawn.

To draw line break blocks, today's close is compared to the high and low of the
previous block. A block is drawn only when today's close exceeds the high or
low of the previous block. If today's close is higher than the top of the previous
block, a new green block is drawn in the next column from the prior high to the
new high price. If today's close is lower than the bottom of the previous block, a
new red block is drawn in the next column from the prior low to the new low
price. If the close fails to move outside the range of the previous block’s high or
low, then nothing is drawn.

With the default Point Break chart, a downside reversal (i.e., green blocks change
to red blocks) occurs when the price moves under the lowest price of the last
three consecutive green blocks. A red reversal block is drawn from the bottom
of the highest green block to the new price. An upside reversal (i.e., red blocks
change to green blocks) occurs when the price moves above the highest price of
the last three consecutive red blocks. A green reversal block is drawn from the
top of the lowest red block to the new high price.

Indicators calculated on Three Line Break charts use all the data in each column
and then display the average value of the indicator for that column.

2~36
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Interpretation/Trading Signals

* Buy when a green block emerges after three prior red blocks and sell when a
red block appears after three green blocks.

Renko

The Renko charting method is thought to have acquired its name from renga
which is the Japanese word for bricks. Renko charts were introduced by Steve
Nison, author of the book Beyond Candlesticks.

Renko charts are similar to Point Break charts except that in a Renko chart, a
line (or brick as they are sometimes called) is drawn in the direction of the prior
move only if a fixed amount (i.e. the box size) has been exceeded. The bricks are
always equal in size. For example, in a five unit Renko chart, a 20 point rally is
dis-played as four equally sized, five unit high Renko bricks.

To draw Renko bricks, today's close is compared with the high and low of the
previ-ous brick (green or red). When the closing price is greater than the previous
brick by the box size or more, one or more equal height, green bricks are drawn
in the next column. If the closing price falls below the bottom of the previous
brick by the box size or more, one or more equal height, red bricks are drawn in
the next column.

If the market moves up more than the amount required to draw one brick, but less
than the amount required to draw two bricks, only one brick is drawn. For example,
in a two unit Renko chart, if the base price is 100 and the market moves to 103,
then one green brick is drawn from the base price of 100 to 102. The rest of the
move -- from 102 to 103 -- is not shown on the Renko chart. The same rule
applies whenever the price does not fall on a box size divisor.

Indicators calculated on Renko charts use all the data in each column and then
display the average value of the indicator for that column.

Interpretation

Basic trend reversals are signaled with the emergence of a green or red brick. A
new green brick indicates the beginning of a new uptrend. A new red brick indicates
the beginning of a new downtrend. Since the Renko chart is a trend following
technique, there will be times when the market induces whipsaws. However, a
trend following technique is intended to allow traders to ride on the major portion
of the trend.

Since a Renko chart isolates the underlying trends by filtering out minor ups and
downs, they are excellent for helping determine support and resistance levels.

2~37
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Kagi

Kagi charts plot a single line until price reverses by a predetermined amount
where another line is then begun. It is an attempt to smooth out the noise of daily
trading activity so that trends can be more clearly represented. The thickness of
Kagi lines are significant when prior highs and prior lows are exceeded.

Scaling
Toals »
Chart Type H
Cursar ¥ & scale Price Data Only
Line Toals ¥ A Log Scale
Auto Scale

Select Auto Scale from the Advanced Chart right-click menu to automatically
scale the active Advanced Chart window. Autoscaling adjusts the Y-Axis to fit
the chart’s high and low prices. If this feature is disabled, you would have to
scroll up and down vertically while scrolling backwards to adjust the scaling.

Scale Price Data Only

Select Scale Price Data Only from the Advanced Chart right-click menu to
scale only the price data in the active Advanced Chart window. This eliminates
applying any price studies to the scaling and makes it easier to read the price
chart.

Log Scale

Select Log Scale from the Advanced Chart right-click menu to apply a
logorhythmic-scale to the active Chart window. A log scale is often used to pinpoint
small price changes in a high priced stock.
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Cursor

Tools »

Chart Type k

Scaling »

Line Tools M || Cursor Tradking
Lock in Place
Small Cursar
Properties...

Cursor Window

Select Cursor Window to display information about various data points in a
summary window. When the Cursor Window is active, the data it displays for
bars and studies updates as you move the cross hairs along the chart. If you hold
down the ctrl key while moving the cross hairs, only the X-cross hair value updates
in the Cursor Window. Hold down shift and only the Y-hair updates.

Cursor Tracking

Select Cursor Tracking to toggle the Advanced Chart window cross hairs on
and off.

Lock in Place

Select Lock in Place if you want the information currently displayed in the
cursor to remain or be locked in place even when you move the chart cross hairs.

Small Cursor

Select Small Cursor to make the cursor small.

Properties

Select Properties to pull up the Cursor Window Properties window.
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Cursor Window Right-Click Menu

When you right-click the Cursor window, you will see a menu similar to the one
shown below:

Symbol: DELL,D

Date: 08/31/06

Time: 00:00

Price: 24 104

Open 22.85 Send Image To L4
High 23.31

et B Hide Cursor Window

Close 2255
DC{20)Upr 23.35 Properties...
DC[20)Lwr 20.65
ey e |~ (DELL - DELL INC,D) Dynamic,0:00-2<:00
DC{Z0)Upr 23.35
DC{20)Lwr 20.65 |ICCRNlsatayit=T 1))

: v Auto Trend Channels
v Donchian(20)

1. Select Properties to pull up the Cursor Window Properties window.

2. Specify your Cursor Window property preferences by selecting/deselecting
from the various options shown.You may also change the Cursor Window font.

3. Select OK to apply your changes to the Cursor Window.

4. The Cursor Window right-click menu also displays other data relating to the
Price (Symbol, Interval), Volume and lists any other studies that have been added
to the Advanced Chart. If you wish to remove any of this additional data from
the Cursor Window to conserve space, simply click on the check mark next to
each item in the right-click menu.
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Cursor Window Properties

Show Time Show Labels
Show Symbol Show Date [ 1short Labels
[]Show Bar Count Show Price [ Left Justify Labels
[]show Bar Index

Show Labels from Left to Right (only matters if # columns is more than 1).

Mumber of Columns;

Font

Font...

Preview Sample

Auto Hide

(¥ Off
") Show when mouse in chart window

{73 Show when chart window is active

[ ] Aute hide Cross Hairs when auto hiding cursor window

Axis Cursor Labels

[]show Cursor Labels In X and ¥ Axis

Text Color: ||:| vI
Background Color: I_ vI

| ok | | cancel
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Tools

Select Tools and then select one of the following menu options from the Tools
submenu to backtest formulas, set price filtering criteria, to Export Data or to
replay chart data.

Chart Type » Price Filtering...
Scaling » Data Export. ..
Cursor » Bar Editor...
Line Tools »

4’ Enter Bar Replay Mode
x Leave Bar Replay Mode
v Tile Studies Go To Date...

Back Testing

Select Back Test to back test a formula that you have applied to the active
Advanced Chart window.

Price Filtering

This filter on the Advanced Charts allows you to set a % range or % average
range of a bar compared to the bars before and after. If a price comes in that is
outside the filtered range, it will be displayed in a different color of your choice
and won’t be used to calculate any studies or to set chart scaling.

[]Enable

Filter bars exceeding
C |
100 % range of nearest bars, and
Criginal Settings
50 %% avg range from nearest bars
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To set up price filtering:

1. Select Price Filtering from the Advanced Chart right-click menu. Alternatively,
select Tools, then Price Filtering from the Chart Options menu.

2. Inthe Filter Bars dialog box, click Enable to enable filtering. Then enter your
desired % range of nearest bars and % average range for nearest bars.

3. Click OK to exit the dialog and apply price filtering.
4. Click Cancel to exit the dialog without applying filtering.

5. Click Original Settings, then OK to revert to the default price filtering
settings.

Data Export

You can export all Advanced Chart data (including data on studies applied to the
chart) in tabular format. Exported data can be either in text format, separated by
commas or, in an html format. You can also copy Advanced Chart window data to
your clipboard and paste it into any other program that accepts clipboard data.

To export Advanced Chart window data, right-click on an Advanced Chart window,
then select Tools, then Data Export from the menu. Alternatively, you can
select Tools, then Data Export from the Chart Options menu (Alt-O,L, Data
Export).

To save the Advanced Chart data to a text file:

1. In the Data Export dialog box that appears, click the Save As Text button to
save data as a comma delimited text file.

2. In the Save Data as Text File dialog box enter the file name you want and
select a special directory, if desired, then click the Save button.

To save the Advanced Chart data to an HTML file:

1. In the Data Export dialog box that appears, click the Save As HTML button
to save data to an HTML file.

2. Inthe Save Data as HTML File dialog box enter the file name you want and
select a special directory, if desired, then click the Save button.

To copy the Advanced Chart data to the clipboard, click the Copy to Clipboard
button in the Data Export window that appears. You may then paste the data into
any application that accepts clipboard data.



eSignal, Part 1 User’s Guide

Bar Editor

Select Bar Editor to edit bar values for the active chart.

Bar Editor
Bar Date Time pen High '_ow Flnse [:J
18 10/25/06 00:00 23.265 23.31 22.8 23.07
1a 10/24/08 00:00 23,42 23,56 123,18 123,28 (al
20 10/23/05 n0:00 23.43 23.93 23.37 3.6
21 10/20/08 00:00 23,36 b23.65 b2.07 j23.54
72 10/13,06 00:00 23,7 23,701 23.05 k312
3 10/18/06 00:00 24.63 24.95 24.18 24.7
24 10/17/08 00:00 04,33 ba,72 4,22 4,54
o5 10/15/05 00:00 24.09 24.73 24 l24.62
s 10/13/06 00:00 23,88 24,331 23.71 23.95
27 10/12/08 00:00 3,12 23,07 3.1 b3.87
23 10/11/05 00:00 23.36 23.69 22.82 22.97
20 10/10,06 00:00 23,53 23,04 3.4 b3.52
20 10/03/08 00:00 23,11 b3.3691 23.11 123,56
1 [05/06 0:00 3.17 23.45 22.95 23.25
22 l10/os/08 bo:0o bz,51 23,56 2,93 b3,29 [oe]
<] i [ [
Reset Bar [ ox | [ concel ]

Enter Bar Replay Mode

Select Enter Bar Replay Mode to enter replay mode where you can replay
chart data.

Leave Bar Replay Mode

Select Leave Bar Replay Mode to exit replay mode so that you can no longer
replay chart data.
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Llne TOOIS - UMagnet
= »
The Line Tools Submenu provides access to all z'el"be T \
tools that are available in the Line and the Advanced Ele fora SYmRes . X
Line Toolbars. For more information about Line Delete (for current symbol)
Tools, see Chapter 3: Line Tools.
)( Pointer

Segment
Ray
Extended
Wertical Line

Trend Lines

<
-~
o
I
== Horizontal Line
N
=

Regression Trend Channels

Eﬂ—gr Fibonacci Retracement
Fel e » E!-?T Fibonacd Extension
ﬂﬁE Fibonacd Time
EE' Propertes... @ Fibonacd Cirde
Style Templates » % Gann Angles
Time Templates v [ GannBox
View v | G TIsElipse
& Andrew's Pitchfork
Tools 3
PTI Frofit Taking Index
Chart Type 3
E Time and Price Squares
Scaling 3

mog Make or Break
Cursor 4

% Text
Q Zoom In

«  Tile Studies ®. Eraser
Stack Studies
Edit Studies. ..
Set Alert 21.1792...
Integrated Trading 4
Basic Studies L4
Advanced GET Studies L4
Add-On Studies r
] Formulas 4
Remaove r
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Un-Merge Studies

Select Un-Merge Studies to un-merge any studies you have previously merged
on the active Advanced Chart window.

Edit Studies

Select Edit Studies to edit a study that is currently applied to the active Advanced
Chart window. Select a study that you want to edit from the pull-down study box,
to edit settings, colors and other display options. When you have finished editing
a study, click OK to apply your changes for that study to the Active Advanced
Chart window. Since you have a pull-down of all studies, you can make changes
to more than one study. Apply This applies the changes for the study and chart
you are cur-rently editing. Apply All applies the changes for all of the edits if you
made changes to more than one study.

(Stiay Properees =2
= EVAB[(DELL —DELL INC,D) Dynamic,0:00 ]| Save As Defait | | Restore Defaut |
Chart Type: | Candle !v}
Up Candle: Candle Cutline:
. | [tolow —
Down Candle: Wick Color:
— | [rolow — |
[ Use Up & Down Bar Color for Candle wicks (default is Wick Color)
[ show Thin Candle Wicks
Qutline Candles

Use Outline Color to outline candles

OHLE Background In Cursor Window | [N j Display Description:
Filtered Bar Color |0 _:]

it ()Mo Display (%) Display Right
{)Scaleleft (MoScale  (#) Scale Right l QK i [ Apply All ] [ Apply This ] [ Cancel
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Basic Studies

eSignal’s Advanced Charting supports many basic studies that you can apply to
your charts. Select Basic Studies to choose from a selection of over 20 technical
studies that you can add to an Advanced Chart window.

Price only studies such as Bollinger Bands appear above the line in the right-click
menu. You can apply multiple studies to Advanced Charts and even merge studies.
For more information about Basic Studies, see Chapter 4: Studies.

Send Image To

@’ Properties...

Style Templates
Time Templates

View

Tools
Chart Type
Scaling
Cursor

Line Tools

v Tile Studies
Stack Studies

Edit Studies...
Set Alert 22,0799...

Integrated Trading

Basic Studies
Advanced GET Studies
Add-On Studies

b

Bollinger Bands
Donchian Channels
Envelope

Linear R.egression
Maoving Average

Parabolic SAR

AccumulationDistribution
Average True Range (ATR)
Choppiness

Commodity Channel Index (CCI)
Directional Movement (ADX,/DM)
MACD

Momentum (MOM)

Money Flow

On Balance Yolume (OBV)

Open Interest

PercentR:

Price Osdillator

Rate of Change (ROC)

Relative Strength Index (RSI)
Stochastic

Yolume
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Advanced GET Studies

eSignal now offers Advanced Technical Studies from Advanced GET, a leading
technical analysis software package as an add-on service. You can add Advanced
GET studies to a Chart window by right-clicking on an Advanced Chart window
and selecting Advanced GET Studies, then the specific tool you want to add
from the sub-menu. For more information about Advanced GET Studies, see

Chapter 4: Studies.

Basic Studies

Advanced GET Studies
Add-On Studies
__| Formulas

Remowve

EENE
GET:
GET:
EEN:
EENE
GE
GET:
GET:
EEN:
EENE
GE

GE
GET:
GET:
EEN:
EENE
GET:

Auto Gann

Auto Trend Channels

Bias Reversal

Eliott Waves

Maving Average

Parabolic
Pivots

Price Clusters
T1= Web
Trade Profile
XTL

Elliott Trigger
JiI

Osc

RSI
Stochastic
Time Clusters

User’'s Guide



Chapter 2 Advanced Charting

Remove

Select Remove from the right-click menu to remove a study from the
Advanced Chart window. Select Remove, then Remove All Studies to
remove all studies that have previously been applied to the Active Chart
window.

Y-Axis Right-click Menu

By default, the Advanced Chart Y-Axis displays the current issue price (color-
coded green for up from the last bar or data point price or red if below the
previous bar or data point’s close), the value of any studies calculated up to
the present time, and the volume for the latest bar or data point displayed on
the Advanced Chart.

Send Image To L

B Hide Cursor Window

Properties...

v (DELL - DELL INC,D) Dynamic,0:00-24:00
v Auto Trend Channels
v Donchian{20)

If you do not want to see the above information on the Y-Axis, just click on
the check mark to its left to remove the data.
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Advanced Chart - Click and Drag Features

Scrolling

You can place your mouse on the X-Axis of an Advanced Chart and move pull or
move it to the right to scroll back in time. Conversely, move your mouse to the
left to scroll ahead in time.

Rescaling

To reset scaling, click the Reset Toolbar button on the Advanced Chart Toolbar.

Resizing

To resize the Y-Axis, click on it and drag it up or down.

Repositioning Studies

You can reposition studies by holding down the Control key, grabbing a study and
dragging it to your desired location.

Merging Studies (non-price)

You can merge non-price studies in an Advanced Chart window. To merge studies,
click on the first study, hold down the Shift key, and drag the study over the study
you want to merge it with. Please note that you cannot merge price studies. To
unmerge a study, right click on the section of the chart where the studies are
merged, then select Un-Merge Studies from the right-click menu.
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Adding Formulas

eSignal’s Advanced Charting supports an extensive library of analytical formulas.
Select Formulas form the eSignal Advanced Chart right-click menu to access a
listing of available formulas.

Send Image To L4

@' Properties...

Style Templates b| ] Advanced r
Time Templates b L] Alerts r
View b || BackTesting ]
] Bollinger »
Tools +
__| EBroker 4
Chart Type »
| Builtin L4
Scaling »
] DiMapaoli L4
Cursaor L4
Cownloads »
Line Tools + _
| EF5 2 Basic r
] EFS 2Custom ¥
+ Tie Studies ] Helpers 3
Stack Studies | Library 3
3
Edit Studies... —1 Msl-msh
3
Set Alert 23.3472... R
] Other 4
i 3
Integrated Trading £ Pivots '
Basic Studies k| _] PlotTypes 4
Advanced GET Studies k| |_] PowerSwings L4
Add-On Studies ¥ | |_| PriceBars 4
T v
Remove r
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Accessing Formula Folders

When you right-click in an Advanced Chart Window and select Formulas from
the menu, you see several different formula folders. The following is an example
of a formula folder and an image of the folder expanded so you can view the list
of formulas it contains. All formula files have the extension .efs, and are stored in

the eSignal directory.

Send Image To L4

@’ Properties...

Style Templates L4
Time Templates »
Wiew r
Tools L4
Chart Type L4
Scaling L
Cursor L4
Line Tools L4
+  Tile Studies
Stack Studies
Edit Studies. ..
Set Alert 24.0132...
Integrated Trading L4
Basic Studies r
Advanced GET Studies »
Add-On Studies r
=
Remove »

[ W Wy W

N Iy Iy I B R Y W A

Advanced
Alerts
BackTesting
Bollinger
Broker

Builtin
DiMapali
Downloads
EF5 2 Basic
EF5 2 Custom

Library
Msl-msh
CHLC

Other

Pivots

Plot Types
PowerSwings
PriceBars

Wizard

3
3

3
3
3

123down.efs
123up.efs

HH.efs

LL.efs

MA Cross Over.efs
MACDColor.efs
RSIColorLine.efs
RSIColorLineBar, efs






